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1. ¥R

Lattice Diamond iR ARt 1 Bt AR THAI S TR, LI 18X A BUR . IKIh#E
s B FPGA BERg AT T AR —— T IR FE AB R 25 FE FPGA (1) S T 75 5 R 1
Uk A ] PR B AR

> T GUI 5EHE FPGA BT FIIRIEFREE

> AL 2 A AR DA K A B SR 0 BN T I E AT R R R

> SRALE AR B A B AR E IR AN Y

£ Lattice ‘B X ] DA %% N BCHT Y Diamond T H, #F Windows Z&ZiA Linux & 45

2. B

2.1 Diamond /4 F#,:

1. F| Lattice B MVEME, B0~ M4k
http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamon
d.aspx

N HON R ERAE RGBT Diamond B4R 34,

2. MR RAR AT 22

3. R VF AR DR BE BRIV Pl E . CHBFEZREL, %)

2.2 Diamond ZEH R

1. XTI R EIF A GEERIRVE RS HIRRAR R BAAF IRRAS) «
2. HNZEH T,


http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond.aspx
http://www.latticesemi.com/zh-CN/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond.aspx
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Lattice Semiconductor Diamend 3.6 (64-bit) Setup ||

(WET< b (sER
MachX02

MachXO Welcome To Lattice Semiconductor Diamond [64-bit] Setup
ECPS

LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

SETLATTICE

InstallShied Cancel
3. siili Next, BEAWRSEE, ARBSAERZS, BERERZ T .o-
Lattice Semiconductor Diamend 3.6 (64-bit) Setup ||

Licenze Agreement
Pl ead thi

the terms and conditions of this Agreement,
MachX03L b. Pursuant ta thiz Agreement, Licensee may [i] physically tranzfer any Software from one
computer to another provided that the Software iz uzed on only one such computer at a time L4
MachXO2 and [ii] uze the Software and any output files generated by the Software for the sole purpose
of desighing and programming semiconductar components manufactured by or for Lattice and
MachXO sold by Lattice or itz authorized distributors ['Lattice Devices') and (il make one (1] copy of
the Softvaare for Licenzee's own uze zolelp for backup or archive purpozes. Licenzes may
ECPS alza merge the Software [or a partion thereof] into any other saftware to farm an updated
) waork; provided that, upon termination of Licensee's licenze, the Software zhall be completely
LatticeECP3 remaved from the updated work and treated as if permizsion to merge had never been
: granted. The use of any portion of the Software included in any such updated wark. remains
LatthEECPE_fM at all times subject to the terms and conditions aof this Agreement.
LatticeXP2 c. Lattice DiamondTM Fragrammer and ispMTM Software License Terms. Matwithstanding
Section 2b of thiz Agreement, Lattice arants ta Licensee the right to uze and distribute, as part
Platform Manager =] of Licensee's systems, the Lattice Diamand Programmer Saftware and the isphM Software (15
he Pragrammer Software?, in compiled wersion, for the sole purpose of programming and
reprogramming silicon devices supported by the Programmer Saoftware. Naotwithstanding the
foregaing, any output files generated by the Software may only be used to program Lattice

LATTICE

InstallShield < Back ‘ Yes Mo |

3
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4, B BERAT, BRI LA C f.

Lattice Semiconductor Diamend 3.6 (64-bit) Setup ||

Chooze Destination Location

folder.

ta a differen

MachXO3L
MachX0z2
MachXO
ECPS

LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

U Uil

Browsze...

[['l:fr;["’ ield | ¢ Back ‘ | | Cancel |
5. BMGERASE, il Next, #EN T HETTH .
Lattice Semiconductor Diamend 3.6 (64-bit) Setup ||

Product Options

produc

MachX03L 1721.7 MB

MachXxoz2 <] Senplity Pro for Lattice 474.7 MB
] Awctive-HDL Lattice Edition 13871 MB
MachXO [ Programmer Drivers 0.4 MB

ECPS
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

SELATTICE

InstallShield < Back ‘ | Mext » Cancel
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6 FRLLFERINBLE, Bl AEl s, B X RFIRILES. i Next, AT RARE
LIRURET DR B C8 47, BHOUER A T

Exizting Folders:

Altera 15.0.0.745
Analog Devices
Atrmel

ATHWEL Corporation

BCL eazuConverter SOK. 4

Cypreszs

EAGLE Layout Editor 7.5.0
Fowrnail

Free Al Wiewer

Fames

&R Syztems

Lattice Diamond 3.5 [54-bit]

7 B R R AL R B . % F USB key, 5t H BEI%E$F Node-Lock License. < Node-Lock License
F Floating License [P X 7l ] LA 2225 R THIIX AN %«
TestComplete 3 ¥FRIIE (Floating license) 5 ™1 m8 %€ 1 P 1IE (Node-locking license) [X J)

Lattice Semiconductor Diamond 3.6 (64-bit) Setup

Active-HDL Lattice Edition Selection

These are the optionz far uzing Active-HDL Lattice Edition simulatar saftware, |F pou zelect
"Floating Licensze wia USE key' option, the drive will be installed later during thiz installation

@ Mode-Lock License

(71 Flaating License via USE key

[riztallS hield

[ M et > ][ Cancel

8. miilt Next, MEFZ ARSI RGER
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Lattice Semiconductor Diamond 3.6 (64-bit) Setup X ]

Create zhortcut on dezsktop

=%
whanld yau like ta create a shartcut on paur computer's desktop to launch the Diamond
software?

(1 Mo

[riztallS hield

[ M et > ][ Cancel

9. il Next, EHFRETE 2% USB IRE), XASLZIFEZ!!!

Lattice Semiconductor Diamond 3.6 (64-bit) Setup X ]

Programmer Download Parallel/U5B Port Driver

=%
Do you wizh ta install ar update the Parallel/LUSE Part driver at this time?T hig driver i required
for Windows YWista Windows ¥ \windows 3 installations.

(71 Ma

[riztallS hield

]| o

10, ERIX—RFNBEE, PSR IGRENE.
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MachXO3L
MachX0z2
MachXO
ECPS

LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

LATTICE

Setup tazks performed to the following folder:
C:Meochdiamond' 3 6_xE4
Options selected ta install:
Diamond Components
Diamond Project Mavigator
Licenze

LATTICE-FPGAs

FPGAs

ECP5IJ-ECPSLUM

LATTICE ECP3

LATTICE ECP2-ECF25
LATTICE ECP2M-ECP2MS
LATTICE SC-5CM
LATTICE =P2

Macke0

LATTICE ®P

LATTICE EC-ECP

4
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InstaallShie!d | < Back ‘

11, gl Next, IEFENZRIANT BV TANLRSE, R R ERE 20,

Lattice Semiconductor Diamend 3.6 (64-bit) Setup

MachXO3L
MachX0z2
MachXO
ECPS
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

LATTICE

InstaallShie!d

Setup tazks performed to the following folder:
C:Meochdiamond' 3 6_xE4

Options selected ta install:

DNiamnnd Camnnnents

@ Setup is evaluating your system. One moment please. ..

LATTICE ECP2-ECF25
LATTICE ECP2M-ECP2MS
LATTICE SC-5CM
LATTICE =P2

Macke0

LATTICE ®P

LATTICE EC-ECP

4

¢ Back ‘ |
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12, —RECE K PC HLAS AT DLE L PPAY . RN 223k,

[ Lattice Semicondutior Diemon S e (ORI Colr T T

=e

.... ‘ ATTI C E Liattice Semiconductor Diamend 3.6 (64-bi) Setup

Installing Diamond Components.
C:\..Atwi_latch_array',_primary.vhd

Cancel

=Proven Pre-Engineered

Reference Designs

=Popular Functions
12C

SPI
GPIO Expander
PWM

Lattice Semiconductor Diamend (64-bit) Installation Completing.

InstallShield Wizard Complete

Dhiarna fiware latior omplete,

MachXO3L
MachX0z2
MachXO
ECPS
LatticeECP3
LatticeECP2/M
LatticeXP2
Platform Manager 2

1 before running

LATTICE

[['l:fr;["’ ield < Back Cancel

14. 57 Finish, SSRGS,
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2.3 Diamond #47:Mt-

1. Diamond HAFALERAL T 187 5. 5 F R AE RS, T HLAR A 40 9% VP nl uEfdi 45 7 ge g 11t
FEVEAY Diamond B A4 S HFIF AN Y SERDES AR IMERE . e %1 nl e SR 87 5, B2 rE
Lattice B WEM—MIKS (FFZ2IE5E).

2. VilaE I L http://latticesemi.com/Support/Licensing.aspx, i #5458 — AN 3 1 AT HE .

Lattice Diamond &1 1H&04

BA— T L EEEsEE | (ERREiED

LATTICE
** DIAVOND

Lattice Diamond 2 ZEiFa]ilE

Lattice Diamondiit 32t rEfcgtenait Izt [ 2 | T BHTAEEesUE, EIhFEa0E
BB FPGAZHERETT I i, RETANHESERAFEEE =TT EDiamondEd=iFrI%
SERDESEY=RIHEIEEE.

FER—MTOLESEE -

WEMACHEOE (1260 +7<3%E )

FRE—aETaiE

3. S LA EME, A license.dat SUIF, 23 Ik BT MBI T HEAE .


http://latticesemi.com/Support/Licensing.aspx
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Please follow these steps to request your Lattice Diamond Free Software license:
1. Review and update your Web Account Information below by clicking on the Update Your Account button.

2_Fill in the Software License Request Form and Submit.

Host NIC: You can find your PC Network Interface Card ID by opening an M5-DOS window, typing "ipconfig /all” and pressing Enter.
The Physical Address is a 12-digit hexadecimal value split into pairs with dashes, like this: 00-01-02-66-1D-E0
Please enter this information without dashes like this: 000102661DE0.

After you successfully complete and submit this form, a new license file with instructions on how to install it will be e-mailed to you.

For any questions, email lic_admn@latticesemi.com

If you have experienced an Aldec license check out error, please check out a new license.

Software License Request Form
Note: The license file will be sent to the web account email address:

it

Host NIC (physical address) *:
* required field

grify that | am not an employee of Cadence Design Systems, Mentor Graphics Corporation, or Magma Design Automation

Generate License

(click once)

NOTE: This form requires JavaScript to be enabled in your web browser in order to process your reguest.

4, {EBMF2AEEREH, CHNBIMARGEH L E. RFPRBRIEN license.dat U5 N 3%
B HF T license AFEH, AXHIN: D:\lscc\diamond\3.6_x64\license\

[ —————————————————————— | | |

@C'| o« EHEESE (F) » lscc » diamond » 3.6x64 » license v|¢,.|| 12E license p|

R wEE) EFJNV) IRM  #EH
iR - aBafEs - HE - ST =~ [l @

Fs

R - EHER =B =

9 FE 2015/11/22 12:33  DAT 3%

m=E | license 2015/4/12 18:19 TS0
Ll SRhEN TS

m

= E
[ B msm
==l
Epe
J =5

o =ra

.
&, #mms ()

’ 2 A%

ZJLSEA License SCAFRE, A LAJFAAREF Diamond #EAT 11T T
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EE!
Ui 77T Diamond B2 BN FEHR, IR AR BB B AT

Error ﬂ

"“-I License checkout failed.

Check environment variable LiW_LICEMSE_FILE

set to:

Chlscetdiamondy3.6_x64\ licensellicense.datf\modeltech_10.1a\L1
CEMNSETXT

Please check your license setup to ensure, I
1) You have a valid Lattice license file pointed to by
LM_LICENSE_FILE

2) The License daemon is started at the server if you have a
floating license.

Failure was caused by

Mo such feature exists.

Feature: LSC_DIAMOND_A

License path:

Chlscchdiamond3.6_x684\ license'license.dat:f\modeltech_10.1a\L1
CEMSE.TXT;

FLEXnet Licensing error-3,337

For further information, refer to the FLEXnet Licensing End User
Guide,

available at "www.macrovision.com”,

BE

PR T2
At EN R, BEAIEHITR T R GRS
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#HERER
& BeTEs
& e
& EEn

EEAAITBINEREE
Windows g3

Windows 7 1Sz
REARRRE © 2009 Microsoft Corporation. SEREIFL.

Service Pack 1

=
S 250 windows st
HHEER Intel(R) Core(TM)2 Duo CPU  T6670 @ 2.20GHz 2.20 GHz
SEAERAM): 6.00 GB
SiEE E, 64 GOBfEESE
e SR NETETHETENEREEE
Windows Update HENER SEITreans
LEtEls THEE: Heng-PC W =mias

[ = (=] ﬂ
N — =TT
U@ [ 2HEE » ZHOSS > 25 MR = o
WA SEE BBV IS ZSH
® -

m

RirRB ARG RE. EFRY, HhAEAEE!

e

—

ENE | w6 |§%ﬁ$|ﬁﬁ |

EHTARZEEN. MENEAEIERS R
{Ed:
MR MBS MTFEER . LRSI

FHPEENF
S5EEFFANEEER
BehingrE g

Fingsh - RahriniitE R

| FREEW... |

[ @& [ BB || EAwW
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NI E R B, BFHPTETR_REMAES RGP & LM_LICENSE_FILE AHM R IAR

=

EHo

(thems

. . o ﬁw

Henz HIFFEE (1)

=8

ALTERAOCISTE. . .

*

=]

F:halterahlS 0%kld

m |

Fath d:"Frogram FileshATMEL Corporat. ..

Q3YS_ROOTIIE F:halterahlS Ohquartushsope_bui. . .

TEMFP FISERFROFTTES drmllata'iTiaralhTamn i
FEw... | [wEE... || BEo |

FHREE G

zE 8 -

FF_HO_HOST C... HO (.

LATTICE THI ... C:‘lsc_enwv

ILM_LICEHSE_FILE C:'l=zcechdiamond'3. f_xE4%\1icensze. .|

WIMEFE NF PR

-

b

gz, | [wmEBo... || W |

| WE || BuE
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3. fIgSE— IR

3.1 HE—ATE

1. 1E Diamond W AFMHEM L, #%E#E File>New>Project, HEATHr TFEG % .

| 4+ Lattice Diamond - § — - pe— E\i |
File | Edit View Project Design Process Tools Window Help
[ New ]* [ Fie.. Ctrl+N | 1
Seen '@ Project.. culeshiteN | > | (R B & @
Add b Implementation... E =
Close Ctrl+F4 Strategy...
Gezeill ject: i User Guides  Reference i
Close Project Oper. 0 L attice Diamaond Guides E
Hew. .. User Guide Strategy
El . Cerl+5 = Managing Constraints
Save As... Projects Hardware
l;_ﬂ] Save All Ctrl+Shift+S  tware Upgrade Recommended é glatform U How-To
Save Project ently running Lattice Diamond software wersion: Gﬁiscllgner ser Lattice
R nooo 4 S Modules
Save Project As... m ] Entering the EOEA | ihrarine -
Archive Project...
i
Discard Modified Preferences g x

Print Preview...

&) Print.. Ctrl+P
Recent Files »
Recent Projects »
Exit

Mem Usage: 92,024 K

2. GUEHT TR, Ak Next, JFIRTAEEE.
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# Mew Project l 2 &]

Create a Lattice Diamond Project

This wizard will guide wou through the creation of a
niew praject.

To ecreate a Lattice Inamond project wou will need to
provide a mame and location for your project. Hext you
will import source files. Tou may adjust implementation
options. Finally wou will process the source files tao
produce a programming file for a specific FPGA dewice.

To continue, clicle Next.

£ Back Hext > I Cancel I

3. WE THEAMMITIEIERR, TR, TAEBGLIEEIFERE TR TR, &
M AT B MRS S E— )2 B AR, FHEAIGER E:/Step_FPGA, | And_Gate
TR SR AEAE Step_FPGA H1. 52K B )5 H i Nexto



STEP-MX02 V2 #4t-F-/1it

-

+ New Project m

Froject Hame

Enter a name for wour project and specify a directory where the Q
project data files will be stored.

Froiect
Hame: and?|
N
Location: F:/Morkspace/fpzaprojectfand? gate * | Browse. ..
Implementation:
Hame: impll

Location: F:/MWorkspace/fpgaproject/and? gatefimpll

[ £ Back ][ Hext > ][ Cancel

A, ISINFHSCHETE SO R . A BRI : 550741k Copy source to implementation
directory, 53 <> 520 S, 0 TR AN L% Nexto
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F N
+ New Project m

Add Source gl
#dd HOL, EDIF netlist, LPF constraints, or other files. Jf’ wal

Source files: Add Sourca. .. Bemowe Source

Copy sowrce to implementation directory

| <Back || Hext> || Comeel |

—— —

5. #HFIEEE: LCMX02-4000HC-4MG132C. b8 T T niEf. 52k B G A Nexto
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r Mew Project e m1
Select Device o
Specify a target dewice for the project. v4 il
Select Dewvice: Device Information:
Family: Device: Voltage: Z.5¥/ 3.3V
LatticeECP | |lcMx02-2000HC  «| W 4320
LatticeECP2 LCMXO2-2000HE Registers: 3zl
LatticeXP —| | LEMX02-2000UHC ERR Bits: w2 2K
LatticeXP2 LCMXO2-2000UHE 1 EfztB;:f:]:“ ’ ;:550 N
MachXO | LCMXO2-2000ZE e _ 1
MachX 02 = || | LCMXO2-4000HC = PLL: 5 1
MachX03L LCMXO2-4000HE DLL: i
MachXO3LF LCMXO2-4000ZE M PCS: -
Platform Manager || LCMXO2-7000HC - AFIO: -
Platform Manager 2 = || 4 C FIO Cells: 280
Performance grade: () Package type: PI0 Pins=: 105
[4 ,.] l:SBGAISZ .,] Max Programmable I0s: 104
Operating conditions: ggg §1ns E
[Commerei al v R Pi:: 0
Fart Hames: Trim/Mar Fins: a
|| LEMi02—4000HC-4mG1 32C ~]| U Pins: 0
GPIO: 1]
Select ASC Dewice:
Fart Hames Humb er =
L-ASC10-15G46T 0 5
|
I Orline Data Sheet for Device |
|| |
[ 4 Back ] [ Hext > ] [ Cancel ]
\

6. Lo LHESR, LA A TR, EARN—BMHE 26 TR, MBEANEE.
B Nexto
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:

[ Select Synthesis Tool \u}":‘)
Specify a synthesiz tool for the implementation. \.-)‘-3“).)
-y
Synthesiz Tools:
) Symplify Pro
Precision
':é:' Lattice LSE More information
N
|
I
|
| |
N
| I
N

[ 4 Back ]I Hext > I[ Cancel ]

7. MEFTE, W TREGE L EMK. A Finish 5t OK T .
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P ™
# New Project m

Project Information )
The new project will be generated with the following specifications. ﬂ?’ il
Project:

Project Mame: and?2

Project Location: F:/Waorkspace/fpgaprojectfand2_gate
Implementation Mame: impl1

Device: LCMXO2-4000HC-4MG132C

Synthesis Tool: Lattice LSE

| <Back || Finish || Cancel

3.2 ¥

1. fE Diamond #K{FHIMR b, 1+ File>New>File, HEATHT CAFG#E .
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Edit View Project Design Process Tools Window Help

New 1> | [File.. Ctrl+N |
Open Y8 Project. Ctrl+Shift+N

Add ' Implementation... E =
Close Ctrl+F4 Strategy.. 5 %
Close All

Eummary il ol
Close Project roject L |
Save Ctrl+5 g Project S.. | | |uodule Name: and2 Synthesis: Lattice b
Save As... rocess Rep... LSE
Save All Ctrl+Shift+S % :I::‘E ar 1impliall'nam:.al.'.i|:rn impll Strategy Name: Strategyl

ame :
save Projlecl ﬁ Signalfpad Last Process: State:
Save Project As... "] JEDEC
Archive Projecl... nalysis Rep... ™ Target Device: ]:.fljt_ﬁ_iﬂ??:wﬂﬂﬂc— Device Family: MachX02 -
Discard Maodified Preferences g x
-

Print Preview... 1scc/diamond/3.6_x64/ispfpga/userware/NT/SYNTHESTS_HEADERS/machxo2.v
Print... Ctelep rors, and (0) warnings
Recent Files » L4
Recent Projects. » i
ok Mem Usage: 105,476 K I
= = —

2. FESCARER S, R EE SR AL ARSI N Verilog HDL &1t 3. ikt 288, &
B AFR. ST Yes, SERGEEE.

i B
* Mew File m

. W e - -

Categories: Souree Files:

Source Files 7 LDC Files

Other Files R Power Calculator Files

R5 Reveal Project Files
B Schematic Files

¥ Verilog Files I
I Y VHDL Files

EZ EDIF Metlist Files
[ Preference Files

Yerilog Files

-~
Hame: I and? I Ext:
Location: F:/Morkspace/fpzaproject/and? gate

£dd to Implementation impll

3. TEHTEIE Verilog U317 Verilog HDL ISR S . w5 5Eml)E, PRAT. IDE HIPKHE
HFE 31 A2 Hierarchy(JZ4X) & 1 o
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Lt Do Snres G TGRSR o ez 5.

Fle Edit View Project Design Process Tools Window Help

B RpRAayHhh GERIUIAAQ

B

o 0 o
YESRAESES® GBI BEEE @
File List & % [ ([ stert Paze ) | [ Reports () | [ amiz.v[ | [
4 1[4 and2 omodule and.
1 LCMXO2-4000HC-4MG132C o (
4 | Strategies
[ Area 2
[ 1/O Assistant b,
% Quick c
[Z& Timing )
Strategyl
« [ impl2 ) input a,b;
4 |, Input Files output cr
¥ andzy P i
J. Synthesis Constraint Files
4 JL LPF Constraint Files. and(c,a,b) ;
[y andzlpf
1. Debug Files endmodule
1. Script Files
1. Analysis Files
1. Programming Files
File Lizt | Process | Wierarchy < i o
Output 8 x
(VERI-1482) Rnalyzing Verilog file C:/lscc/diamond/3.6_x64/ispfpga/userware/NT/SYNTHESIS HEADERS/machxoZ.v -
(VERT-1482) Rnalyzing Verilog file F:/Workspace/fpgaproject/and?_gate/and2.v
INEQ - F:/Wurkspaca/fpgaprujecc/andzigacalandz.v(l,af:l.lz) (VERI-1018) compiling module and2
INFQ - F:/Workspace/fpgaproject/and?_gate/and2.v(1,1-13,10) (VERI-9000) elaborating module 'and2’
Done: design load finished with (0) errors, and (0) warnings D
Outpat | Tel Console | Erver | Warming | Infox |

Ready Mem Usage: 120,744 K
— T ——

AR AN T -

. module and_gate(
input wire a,b,

output wire ¢

~
<~

and(c,a,b);

©® NV WN R

. endmodule

4, Y HIFAHY, FREIATIOUE. 78 IDE £, %% Process. X7 Synthesis Design, Xfi 11
WATSE
i o s R R 5ea 2 ™ - - -

Fle Edit View Project Design Process Tools Window Help

B-E- 2R Y M@

AR Qs

& "]

YEACHBSES G GRA=ga<-08> MEERE @
Process 8 % [ stert Page [ | Reports [] | [ andz.v [0 | [5]x
4 & Synthesize Design omodule and2
& Lattice Synthesis Engine 50

4 2 Map Design
Map Trace 2
Verilog Simulation File b,
VHDL Simulation File c

4 2 Place & Route Design ):
& Place & Route Trace

& 1/O Timing Analysis

2 Export Files

2 IBIS Model

& Verilog Simulation File

2 VHDL Simulation File

& JEDECFile

input a,b;
output c;

and(c,a,b);

2 Bitstream File endmodule
File List | Process | Hierarchy a [ D
Output & x
(VERI-1482) REnalyzing Verilog file C: /ls::::/diamnnﬂfz.Gixallfispfpga/\lsErwara/NT/SYN’II{ESISJ—[EADERS/machan.v -

(VERT-1482) Analyzing Verilog file F:/Workspace/fpgaproject/and2?_gate/and2.v

INFO - F:/Workspace/fpgaproject/and2_gate/and2.v(1,8-1,12)
INFO - F:/Workspace/fpgaproject/and2_gate/and2.v(l,1-13,10)

(VERT-1018) compiling module and2
(VERI-2000) elaborating module 'and2’

Done: design load finished with (0) errors, and (0) warnings

Gutpst | Tel Console | Error | Warming | Infox |
Ready

Mem Usage:

120,744 K

— e == W
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FRHRA [, AR T2 SO T oo A AR A AN X X oo BARITELHE
RBEEERMA AT, EAERNS?
Process H X

4 |3 Synthesize Design|
T Lattice Synthesis Engine

a g Map Design
[ = Map Trace
[[] & Verilog Simulation File
[[] 2% VHDL Simulation File
4 2 Place & Route Design
[[] 2 Place & Route Trace
[[] & 1/O Timing Analysis
4 2 Export Files
[ & IBIS Model
[ & Verilog Simulation File
[ 2 VHDL Simulation File
= JEDEC File
[[] 2 Bitstream File

Fi=- Fre-- Hierarchy—-Fost 5

3.3 B

1. ET ARG FEE =ATH b, i B AT N8 I Be 5 1

File Edit WView Project Design Process Tools Window Help
PrE-HeB|rayg M GEBRRQAAQEEH|EE R Q
[ecAecracEEGA=LUO<sB8Y REFEE 6

Froceszs g x | ﬂ Start Fage |:| | = Reports |:| | Rfandz.vﬂ |

o 1% £ Tools->Spreadsheet View
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« Lattice Diamond - Source Editor - [F:;/Workspace/fpgaproject/and2_gate/and2.v]

File Edit View Project Design

#-E-Ha
CECHAS.

Process

8 x

Process
B2 e 4
FH % @ E E

4 % Synthesize Design
% Lattice Synthesis Engine
4 2 Map Design
[ 2 Map Trace
] 2 Verilog Simulation File
] ¥ VHDL Simulation File
4 2 Place & Route Design
] & Place & Route Trace
] 2 1/O Timing Analysis
a 2 Export Files
] 2 18IS Model
] & Verilog Simulation File
2 VHDL Simulation File

-
& JEDEC File
7] & Bitstream File
Fi-= Pr--- Hierarchy—-Fost 5=
Output

Tools] Window Help

7

T X

5
%
@
]
i
@
ia

0 &

(- Y]

Peak Memory Usage: 55.4%2 MB

N &

Elapsed CPU time for L5E

flow :

1.

Spreadsheet View

Package View

Device View

Netlist Analyzer
Netlist View
NCD View

IPexpress

Reveal Inserter

Reveal Analyzer

Floorplan View
Physical View r
Timing Analysis View
Power Calculator
ECO Editor

Programmer
Partition Manager

Synplify Pro for Lattice
Active-HDL Lattice Edition

Run Manager

Simulation Wizard

Clear Tool Memory

Done: completed successfully Options...
e
Output | Tl Conzole | Ervor | Warningt | Infok |
Spreadsheet View Mem Usage: 123,676 K
—_— = |
peren Lo A 2o L L
2. BRI FEENARIT . a—-keyl,b-——-key2,c—-ledl. TEMKE G, Ctrl+s {RAE % E .
Name Group By Pin BANK BANK_VCC VREF I10_TYPE PULLMODE DRIVE SLEWRATE CLAMP OPENDRAIN
1 4 T AlPors MIA MNIA MNIA MNiA MIA MNIA MNIA
11 4 W Input A MN/A MNIA IIA A A MN/A MIA /A i
111 » a L14 1 Auto NiA A NA On OFF ol
112 b M13 1 Auto NiA A NA On OFF ol
12 4 Qutput /A N/A N/A NIA \IA N/A MNIA NIA N/A NIA /A Ny
121 ] NIA N13 1 Auto NIA DOWN 8 sSLOW OFF OFF Q1
4 m ] 3
Port Assigaments | Fin Assigmments | Clock Resource | Route Priovity | Call Wapping | Global Fraferences | Timing Prafersmces | Grouwp | Misc Erefsrances

3.4 ARG IFEXMFE TR

1. HFARBO R R, SRR R AR ATk A i S — 2 — A G KK

fEIE,

R VRRS, A vt fi] 3R] BB 2R il 2 3P
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B X

Frocess
4 % Synthesize Design
% Lattice Synthesis Engine

4 % Map Design
O :: Map Trace
[ & Verilog Simulation File
[ 2 VHDL Simulation File
4 % Place & Route Design
[[] 2 Place & Route Trace
[[] = IO Timing Analysis
4 Z Export Files
[[] = IBIS Model
] & Verilog Simulation File
[[] 2 VHDL Simulation File
%{ JEDEC File|

[ & Bitstream File

| Fi=- | Fre=- | Hierarchy——Fost M- |

2. SERIRIESE, AT DL R R SCE R BRI T e T EAR AT L EIF5 o
File Edit View Project Design Process Tools Window Help
H-EB-Ha 8 @‘EIE%@EE €i|f='+\s'¢_3% il EE L

?ECHARSNGSCEEG -a.\«-nfa FREEE @
g X | G. Start Fage |:| % Reports || | D’. an62v|_| | .&‘?Sllreadsheet \flerm [

Process

7] PLi%E$E Tools->Programmer,



STEP-MX02 V2 #4t-F-/1it

-
« Lattice Diamond - Spreadsheet View

= [ B [ |

- e
File Edit View Project Design Process Tools] Window Help
B-E-Ha & 8 2 % M MEF Spreadsheet View = &l el
YECEBLHE G @ ERE K PckgeView EEMHEE:®
Frocess & | [ @ 2 Deceilie [/ andz.w [ | | 1% Spreadsheet View [£] : x
< - - Netlist Analyzer ——
4%
¢ Synthesize Design & o By Pin  BANK  BANKVCC  VREF 10_TYPE
%L Lattice Synthesis Engine B Netlist View - )
iy Map Design i g NCD View MNIA MNIA LVCMOS33
] 2 Map Trace b NAA A NIA NIA NiA
. . N =L
= i.: Verilog Simulation File me B IPexpress L4 10 Auto NIA
[[] & VHDL Simulation File )
- T || Wi, Reveal Inserter (1) Aute MIA
4 % Place & Route Design : v W13 to M
] 2 Place & Route Trace % | @ Reveal Analyzer NA N NIA NIA NIA
- . . p—
. 00 ¥ O Timing Analysis @ Floorplan View N13(. 101 Auto NIA LVCMOS33(LVCH
4 T Export Files % ol
[] & IBIS Model Y JEEl U
- . . A
[[] & Verilog Simulation File @, Timing Analysis View
7] 2 VHDL Simulation File @ Power Calculat
; er Calculator
%L JEDEC File [ .
7] & Bitstream File a7 2E ECO Editor
z
§ui Programmer I
&
12} €N  Partition Manager
iy . . 3
=~ || == Synplify Pro for Lattice
Fir= Pree- Hierarchy—-Fost M- | ¥ m Active-HDL Lattice Edition I Clock Resource Eoute Friority I Cell Mapping I Globa 1| }l
Output [
% Run Manager
Device: LCHMX02-4000HC 53 3 -
Package: CSBGEA132 ' Simulation Wizard
Performance: 4
Fackage Status: Clear Tool Memory
Performance Hardware Data 5tatus: . m
Finish loading physical design infol Options... jae
Output | Tl Consale | Errer | Warming | Infe |
Ready Mem Usage: 178,700 K
e —— )

3. {EBEN FPGA ZifEdT, IDE 2ALMIAA T E, Wt I THIEM 2K E, = H3)

W, PRI FE BRI AT

-
iwf Programmer: Getting Started

L2 [ |

Select an Actien

@ Create a new project from a JTAS sean

Cable: |HH-USEN-2E (FTDI) v | Port: [FTUSE-0 v][

Detec

t Cable

(7} Create a new blank project

(") Open an existing programmer project

| |
F:Morkspace fpzaproject 123 impll fimpll . ef
Import file to current implementation I
|
F:/Morkspace/fpzaprojectfand? _gatelimpllfimpll. xeof E]
| 0K || Cemeal |
.

4. HENGRE FEOAIE, SRR O
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i) Start Page [) | [ Reports [0 | [2 ani2w [) | 1/ Spreaishest Vier [] | 1) Programmer - impll.xef x [J | [=]x
2 eee g[EE
Enable Status Device Family Device Operation File Name |-
Cable Settings

1 MachX02 LEMX02-4000HC FLASH Erase,Program Verify ..ace/fpgaproject/and2_gate/im

Custem port:

[

170 Settings
@ Use default I/0 settings

(01 Use custom If0 settings

IHITH pin connected

Cable and If0 Settings

DONE pin comnected
TEST pinm comnactad

@ Set TEST high

Set TEST Low
< 11 3 PROGEAMH pin connected -
5. NEUGEHUE, SR PASS.
| 6 Start Page |:| | | Reports |:| I |"_f and?. v |:| | L@ Spreadsheet View |:| | ul’rog:ruler - ilpll.xcfﬂ

BEE RS

Enable Status Device Family Device Operation File Name

1 -4I|sch)(02 LCMXO2-4000HC FLASH Erase,Program, Verify ..aceffpgaproject/and2_gate/im

m3 T Caa:

[

Zt, FrLEMCIERZRE LI, BRI IE TR C R

FETRMAEFER NEREVNAY ERRREFBITER 1 Sl — MR A S 1125, F
FHPAN 4 (keyl. key2) SK4%4] LED AT (ledl) HIFEK. 7E FPGA #i b led1 IME 5 A&,
ledl A5%; 24 ledl (15 5 NMKHT, ledl fi5E. M4 keyl Al key2 WIURIRS SR, %%
TNEHME 5K FTUREFIEAT G, AR — MR MR RIN X T, ledl 85 B MIE,
led1 NiZ A5
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3.5 /NG

&GS —F FPGA [ — R IF R AP BR:

1. BV TR, B TERE, Shki

2. WX, — R BTSRRI 720, STRIE, — A ml i Verilog #2018
3. IELEA (Synthesis), AT MR ZIRKIE KB T RAEFHAWNICZRBERKHE, —
R LA RS RTL JZ KA

4, WIMAER, BFEHFECER, BT LUEH BRSO AP 7 20

5. SZHl(Implementation), SCHLIPAIER SCAE, MR Lk

6. HilE (Verification), RLF&EMN F7 HAIIBEMI ., — =455 ModelSim 4w’5 testbench i3
A7

7+ AR #E bitstream SO

8. FE AR RIFF AR, CFEJ H A BN E

9. FORER

PO T B ) A AT DA R A () — BP0, B4 EARCE R

4. {FE T E Active-HDL

FPGA it ik — AN EE B Bt 21 5, Diamond # A4 T & FK 15 7] I 45 i T
Active-HDL T.E, NHEA WMAHFITIHREE

1. EYHTE A testbench SCfF, JHEATETE Verilog JE3CAF—FE. FATdr 448 and2_tb
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Fle Edit Wiew Project Design Process Tools Window Help
A-B-rddB|ra¥ih GERMRRALAS | EEH)EREE D
?ECHEECESCEEGR=LOAosDB> FREHEHE:G

File List F X Start Page D | 2| Reports D | D’Iudz_tb_vm |
4 ([ and2 “timescale 1ns/100ps
il LCMXO2-4000HC-4MG132C
4 | Strategies
) B ° cmodule and2 tb;
Area —
|§§9 1O Assistant
% Quick reg a,b;
[ Timing wire c;
Strategyl
< [ impi2 -| initial
4 | Input Files .
¥ and2v = begin
I ni and2_tha a=0;
.. Synthesis Constraint Files b=0;
4 || LPF Constraint Files #50
[ andzlpf a=1;
|, Debug Files b=0;
| Script Files #50
1 Analysis Files
- a=1;
4 | Programming Files
impl1/implLxcf b=1;
¥50;
File List | Process I Hierarchy | 1 — L1
Jutput

2. testbench M ST AU :
“timescale 1ns/100ps
module and2_tb;
reg a,b;
wire c;
initial
begin

a=0;
b=0;
#50
a=1;
b=0;
#50
a=1;
b=1;
#50;
a=0;
b=1;
end
and2 and2_ul(
a (a),
b (b),
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.C (c)
);
endmodule
3. X EFREE RN RS R HRITER, REBARALEGH, e ERE
gV 72T H sk B8 R and2_tb SUAF,

4 [[} and2

L LCMXO2-4000HC-4MG132C
4 | Strategies
E&’" Area
% 1/O Assistant
% Quick
% Timing
Strategyl
4 [EH impl1
4 || Input Files

¥ and2w

and2_tl--

end

. Synthesis ( Open

4 || LPF Constr Open With... and2 ul(
Y and2.g Cpen Containing Folder .a
. Debug File b

. Script Files Add k
Analysis Fil Clone Implementation...

T — —

. Programm Clone Strategy... ) ;

impll/ Find Files...
dule

Exclude from Implementation
File List Frocess I Remove

Jutput
(VERI-1482) Analyz

Set Top-Level Unit... /fpgaproject/andz_gat

INFCO - F:/Workspac Select Synthesis Toal... th.v(3,8-3,15) (VERI-
INFO - F:/Workspac tb.v(3,1-29,10) (VERI
INEC - F:/Workspac Include for * |vi1,1-13,10) (VERI-90
Done: design load Pr::rperties (0) warnings

s AN RYEE O, BN R PEE SO simulation Rom R H.
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-~
% Project Properties - ug
| 4 [[f and2

- Hame: and?_tb. v Category: Resource
i LCMXO2-4000HC-4MG132C
4 EE iI‘I‘IPll Location: F:fWorkspace/fpgaproject/and? gate

and2wv
and2 thav Hame Yalue
and2.lpf Verilog Include Search Path
impll/impllxcf

E% Area Include far Simulation -

E® 1/O Assistant
E¥ Quick

E® Timing
Strategyl

[ & ][ camca

A, S TR L S P

File Edit View Project Design Process Tools Window Help

A-B-HI B @ ¥ h RAQde BE CEEQ
PECHAECESCEEGA=LUOoB | RFaEE @

File List g X | Start Fage Beports D | E.fandz_tb.vm |

{3 #& Tool->Simulation Wizard

» Lattice Diamond - Source Editor - [F/Workspace/fpgaproject/and2 gate/and?. b1 - — (| O )
File Edit View Project Design Process Window  Help
B-E-da 02 2 Y ()[R 1% Spreadsheet View [T]
o Package Vi
YESRAESES® RSN M E = E& @
File List 5 X BerzelEy E x
a2 and2 Netlist Analyzer n
1 LCMXO2-4000HC-4MG132C Netlist View
4 strategies NCD View
Area
[B¥ 1/0 Assistant BS IPexpress
i
g?w W, Reveal Inserter
iming L
Strategyl @ Reveal Analyzer E
< Eimp B Fioorplan View
4 . Input Files Physical Vi
¥ andzv B Physical View
i anel2 tb @y Timing Analysis View
J. Synthesis Constraint Files @ Power Calculator
4 | LPF Constraint Files
[ and2lpf 3 ECO Editor
|| Debug Files i Programmer
1 Script Files »
1\ Analysis Files €N Partition Manager
4 i Programming Files < Synplify Pro for Lattice
Y implL/implLxcf . o
impl1/impl Active-HDL Lattice Edition
File List | Process | Mierarchy | 8 Run Manager i o
— E“ Simulation Wizard | —
(VERI-1482) Analyzing Verilog file Clear Tool Memery ga/userware/NT/SYNTHESIS_HEADERS/machxo2.v
(VERT-1482) Analyzing Verilog file _gate/and2.v
INFO - F:/Workspace/fpgaproject/and. Options.” —1018) compiling module and2
INFQ - F:/Workspace/fpgaproject/andz o - - 1-9000) elaborating module 'and2®
Done: design load finished with (D) errors, and (0) warnings o
Output | Tol Consele | Error | Warndnge | Infor |
Ready Mem Usage: 196,908 K

—— = L—

5. T HFSE D,
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-

2t Simulation Wizard Iili:—hl

Preparing the Simulator Interface

Thiz wizard will guide you through the creation of a new simulation project for
a specific simulater.

To create a nmew simulator project you will need to prowide 2 name and location
for your project. Hext you will indicate what stage of the FPGA implementation

wou wish to simulate.

Click Wext to continue.

< Back Hext > ] [ Cancel

L ——

6. LI HMITIEL -DAT,

2t Simulation Wizard Iili:—hl

Simulater Project Hame
Enter a name for yowr simulator project and specify a directory where the project file
will be stored

Project name: test
Froject location: F:/Workspace/fpzaproject/and? gate :]
Simulator
@ hective—HIL
ModelZim BuestaSim

[ < Back ][ Hext > ][ Cancel

L ——

7. EPEOTEM B, X ERIIRAIE, BT REIE RTL 2.
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r N
2t Simulation Wizard &Iﬂ—hj

Process Stage
Indicate what process stage of the FPGA implementation strategy you wish to simulate.
hvailable stages are antomatically displayed.

Frocess Stage
@ ERIL
Post—-Map Gate-Lewel

Foszt-Reute Gate-LeveltTiming

| <Back || Fext> || Cancel |

L = =

8. EFRUN I M B BT B0 B AR SRS, WA T Copy Source to Simulation
Directory BT, K% DIJESCAF R0 TR H %

r N
2t Simulation Wizard &Iﬂ—hj

Add and Reorder Source
Add HOL type source files and place test bench files under the design files.

Source Files: E]

F:/Workspace/fpgaprojectfand2_gatefand2.v
F/Workspace/fpgaproject/and2_gatefand2_tb.v

I D Copy Source to Simulation Directery I

Automatically set simulation compilation file order

[ < Back ][ Hext > ][ Cancel

L = =

9. MIHEIRESIZR, WRA L NMHCAF AT LR TR AT
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-

2t Simulation Wizard

7 -t |

Parse HIL

———

== Anazlyzing
—— Analyzing
-— hnalyring
== Anazlyzing
— hnalyzring
-— Analyring
—— Analyzing
-— Analyring
== Anazlyzing
—— Analyzing
-— hnalyring

Parse HDL files for simulation

files for simulation.

Simulation top parsing finished.

e i —

VHIL file C:/lscefdiamond/3. 6_x64/ispfpzaivhdl_packages/=td_logie_textio. vhd (VHDL-1481
VHOL file C:flscof/diamond/3. 6_x84fispfpzalvhdl_packages/syn_attr. vhd (VHDL-14811

YHOL file C:fl=sce/diamond/3. 6_xB4/i=pfpza/vhdl_parkages/=yn_mize. vhd (VHOL-14&1]

VHOL file C:/lscefdiamond/3. 6_x64/izpfpzafvhdl_packages/mixed lang wltype. vhd (VHDL-14¢
VHOL file C:flsce/diamond/3. 6_xB4fispfpzafvhdl_packages/syn_arit. vhd (VHOL-1481]

VHIL file C:/lscefdiamond/3. 6_x64/ispfpga/vhdl_packages/=yn_sign. vhd (VHDL-1431)

YHOL file C:/lscefdiamond/3. 6_x64/ispfpeafvhdl_packages/syn_unsi. vhd (VHDL-1481)

YHOL file C:flsce/diamond/3. 6_xB4/ispfpza/vhdl_packages/symattr. vhd (VHOL-1451]
Verilog file F:/Workspace/fpzaproject/and?_gatefand? » (VERI-1482)

Verilog file F:/Worlkspace/fpzaproject/and?_gatefand?_th w» (VEREI-148Z2]

YHOL file C:fl=sce/diamond/3. 6_xB4fcae libraryf synthesis/vhdl /machxa? vhd (WHOL-1431)

e - —————e

m

|

UL

Simulation Top Module: |and? th

e

10, P H TAETH B SE R, WER T IETE, KA 5e e B s AT 0 BOF Ron it 3

.

-

2t Simulation Wizard

7 -t |

Summary

Simulator : Active-HDL
Project Name : test
Project Location : Fi/Workspace/fpgaproject/and2_gate
Simulation Stage : RTL
Simulation Files :
F:/Workspace/fpgaproject/and2_gate/and2.v
F:./Workspace/fpgaproject/and2_gate/and2_tb.v
Simulation Libraries :
pmi_work
ovi_machxo?2

Simulation Top Module

m

Bun zimulator
Add top-lewel signals to waveform display
Bun simulation

< Back ][ Finish ][ Cancel

e

11, e R SR, PUTITEERITREEIE .
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B Active-HDL 10.2 {test test) - untitled.awc *

[ @] = |
— S |
Eile Edit Search View Workspace Design Simulation Waveform Tools Window Help Ao x
P-Eld|zu B @y BLREa YO T ®m @[5 oS8 » e w00ns He w g [E=l=="
Design Browe Wk LS mEm A LA AL v LA BRERAT NS
lﬁ'ﬁ,andZ_lb Signal name Value E - T L L B
Hierarchy - ma 0 ] l =
ar b 1
ar G 0
Ak and2_ul : and2
B @INITIAL#E 0@ ~ g
| El
Name |Va\ue ]
F=a 0
F=b 1
. R Cursor 1 .
c
o 0000 =)@
‘ i & wave.asdb SIM
[21 Files ;$#Stru... ‘TaRes.../ | sumtitle. ..

=# Simulation has been initialized

=# Selected Top-Lewel: and?_tb (and?_tbh)

= add wave *

=# 3 signal(s] traced.

= run 1000ns

= # Waveform file “untitled. awe’ connected to ' F:/Workspace/fpgaproject/and?_gate/test/src/wave. asdb’.
«# KERNEL: stopped at time: 1 us

# KERNEL: Simulation has finished. There are no more test vectors to simulate.

B Console

I I T

5. R4

AR Bk 1 3] Bl

V1.0 2016/8/28 WIGERRA

V1.1 2017/1/20 BT TNV 1R




